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Thank you for purchasing the ARTURIA’s HIPHOP PRODUCER! 

 

In this package you will find: 

• One DVD-ROM containing a unique installation program 

• One Registration Card (credit card format) holding license numbers and activation codes 

• One 68-page paper user’s manual in English 

 

 

In order to obtain: 

• the activation code to authorize Analog Factory HipHop Edition 

• the serial number to authorize Live Lite 8 

• the serial number to authorize Lounge Lizard 

���� You need to register your HipHop Producer pack at http://www.arturia.com/login 

 

 

 

 

 

 

 

 

 

 

Information contained in this manual is subject to change without notice and does not represent a 

commitment on the part of Arturia. The software described in this manual are provided under the 

terms of their respective license agreements or non-disclosure agreements. The software license 

agreements specify the terms and conditions for their lawful use. No part of this manual may be 

produced or transmitted in any form or by any purpose other than purchaser’s personal use, 

without the express written permission of ARTURIA S.A. 

All products, logos or company names quoted in this manual are trademarks or registered 

trademarks of their respective owners. 

All technical assistance shall be handled by the concerned software proper editor. Arturia 

does not take any responsibility in third-parties software technical issues handling. 

This user’s manual has been designed and realized by Fabien BRASSELY and Antoine BACK. 

 
© ARTURIA S.A. – 1999-2009 – All rights reserved. 

4, chemin de Malacher 
38240 Meylan 

FRANCE 
http://www.arturia.com 
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1. HipHop Producer Installation 

To install the HipHop Producer you just have to follow the instructions on the screen. 

First, insert the disk in your DVD drive. 

On Windows, launch the “LauncherHipHop.exe” file: 

 

On Mac OS X, double-click on “LauncherHipHop.app”: 

 

Welcome to the HipHop Producer installer home screen: 

 

Click on the software icon you want to install.  

For a full install, and in order to prevent any 
incompatibility or bad plug-ins recognition, please follow 
the suggested installation order: 

1. Live Lite 8 

2. Analog Factory HipHop Edition 

3. Lounge Lizard Session 

4. ModernBeats HipHop 
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1.1. Install Ableton Live Lite 8 Arturia Edition 

Click on the “Install Live Lite 8” icon to begin the installation: 

 
 

1.1.1. Mac OS X 

Click “Continue”: 
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Once you have read and approved the Ableton EULA, click on “Agree” to continue the installation: 

 
 

Then click on “Install” to start copying the files on your hard drive:  

 

Wait until the installation is complete: 
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Live Lite 8 Arturia Edition is now installed. 

1.1.2. Windows 

Click “Next”: 

 

 

Once you have read and approved the Ableton EULA, click on “I Agree” to continue the installation: 
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Select the installation folder and click on “Next”: 

 

 

 

Click on “Next” to start copying the files on your computer: 
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Ableton Live Lite 8 is now installed. 

 

1.2. Install Arturia Analog Factory HipHop Edition 
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1.2.1. Mac OS X 

 

Click “Continue”: 

 

 

Once you have read and approved the Arturia EULA, press “Agree”: 

 
 

If you want to change the default installation folder, click “Change Install Location…”, otherwise 
simply click “Install”: 
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Analog Factory is now installed. 

1.2.2. Windows 

Click “Next” to continue: 

 
 



ARTURIA – HIPHOP PRODUCER – USER’S MANUAL 15 

Once you have read and approved the Arturia EULA, select “I accept the agreement” and click 
“Next”: 

 
 

Accept or change the installation folder, then click on “Next”: 

 
 

To avoid any compatibility issue, we recommend you to install all the components. So simply 
click on “Next”: 
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Click on “Install” to start copying the files on your computer: 

 
 

 
 

Click on “Finish”: 
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The Analog Factory HipHop Edition installation has now completed. 

1.3. Install Lounge Lizard Session 

 

1.3.1. Mac OS X 

Click on “Continue”: 

 

Once you have read and approved the license agreement, click “Agree”: 
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Then click on “Install” to start copying the files on your computer: 

 

 

Lounge Lizard Session is now installed. 

1.3.2. Windows 

Once you have read and approved the license agreement, click “I Agree”: 
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Accept or modify the install folder, then click on “Next”: 

 
 

 
 

Lounge Lizard Session is now installed. 

1.4. Install Modern Beats HipHop Sounds 

In this Arturia edition, banks come as Ableton Drum Rack patches. Click on Modern Beats Icon to 
install the sound Banks: 
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Ableton Live Lite starts. Click on “Install”: 

 
 

 
 

 
 

Now you can explore the sounds bank in the Live library: 
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1.5. Registration & Authorization 

Once all your software pack is installed you have to register online as a licensed HipHop Producer 
user. This registration is necessary in order to obtain: 

• the activation code to authorize Analog Factory HipHop Edition 

• the serial number to authorize Live Lite 8 

• the serial number to authorize Lounge Lizard 

…as well as direct access to the Arturia Technical Support, reserved resources for new 
presets, and latest news on upcoming updates. 

Make sure to keep this information in a secure place! 

 

 The Arturia Technical Support Department handles the technical issues referring to the global installer and to the Analog 

Factory HipHop Edition only. For any other issue related to Live Lite, Lounge Lizard Session or Modernbeats HipHop Sounds, 
please refer to their respective editors: 

• Ableton:    http://www.ableton.com/support 

• Applied Acoustics Systems: http://www.applied-acoustics.com/support 

• Modernbeats :   http://www.modernbeats.com/contact 
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2. Ableton Live Lite 8 

 

 

Welcome to Ableton Live Lite  

This Getting Started Guide will teach you how to install Live Lite and set up your audio and MIDI 
hardware. You’ll also learn a bit about how Live works and how to get more information.  

2.1. Installing Ableton Live Lite  

Find the Live Lite installer on the CD or DVD supplied with your hardware and double-click to install 
it.  

2.1.1. Mac OS X 

To launch Live, locate and open the Live application folder and double-click the Live icon.  

2.1.2. Windows  

To launch Live, select it from the Start menu.  
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2.2. Authorizing  

The first time you launch Live Lite, you will be presented with a dialog window containing 
instructions for authorizing. If you have an internet connection on the computer on which you’re 
installing Live, you can authorize online. Otherwise, you can authorize on another machine with an 
internet connection.  

For more information or help with authorization, see:  

http://www.ableton.com/authorization-live8 

You will need to enter a serial number in order to authorize Live Lite. Your serial number can be 
found in your Arturia account once registered the HipHop Producer pack (see Chapter 1.5).  

2.3. Setting up Hardware  

Before you can use your MIDI or audio device, you may first need to install drivers. Consult the 
documentation that came with your hardware for more information. Once you’re sure your 
hardware is attached and working properly, you’ll need to configure Live to use it. Audio hardware 
is set up in the Audio tab of Live’s Preferences window, while MIDI hardware is set up in the 
MIDI/Sync tab. 

 

For more detailed information about setting up your hardware, see the Lessons called “Setting up 
Audio I/O” and “Connecting MIDI Controllers.” Live’s built-in Lessons are always available by 
selecting Help View from the Help Menu.  

 

2.4. The Fundamentals  

The type of document that you create and work on in Live is called a Live Set. The basic musical 
building blocks of Live are called clips. A clip can be any piece of musical material: a melody, drum 
pattern, bassline, or even a whole song.  

A Live Set consists of two environments that can hold clips: Arrangement View uses a musical 
timeline, with time represented horizontally and tracks stacked vertically.  
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Session View is a real-time-oriented “launching base” for clips. You can switch between 
Arrangement and Session at any time by pressing the Tab key on your computer keyboard.  

 

2.5. Recording Audio  

To record into a track in Arrangement View, connect the output of your instrument or microphone 
into one of the inputs on your audio hardware. Then make sure that the In/Out and Mixer 
sections are visible in Arrangement View.  

 

Use the input choosers in the In/Out section of the track to select the input that your instrument or 
microphone is connected to.  

 

Arm the track for recording.  
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Press the Global Record button to prepare Live for recording. Then press the Play button or the 
computer’s space bar to start recording.  

 

2.6. Finding Sounds  

Live Lite comes with a Library full of loops, presets and effects. You can 
quickly browse to various types of Library content by using the links in the 
Sounds section of Live’s Help View.  

To load Library content, drag it into Live’s work area.  

2.7. Learning More  

To learn even more about Live, follow Live’s comprehensive set of Lessons, 
which are available from the Help View. For a general introduction to Live’s 
workflow, try the Lesson called “A Tour of Live.” There are also lessons 
about specific production concepts such as creating beats, playing software 
instruments and DJing.  

Live’s Info View tells you the name and function of whatever you place 
the mouse over. This is a great way to learn about Live as you work.  

For an in-depth look at all of Live’s functions, read the Ableton Reference 
Manual, which can be opened from the Help Menu or from a link at the 
bottom of the Help View.  

 

There is an ever-expanding collection of movies 
available at http://www.ableton.com/movies. 
These include tutorial videos, artist interviews and 
more.  

Finally, you can learn from Ableton’s active online community at 
http://forum.ableton.com. 
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3. Analog Factory HipHop Edition 

 

3.1. Introduction 

3.1.1. History 

In early 2001, Arturia began working on an advanced algorithm for the digital emulation of analog 
circuits’ audio characteristics. In non-technical language, this is an unprecedented way of creating 
the very unique sound one finds in a synthesizer such as the Moog Modular. Nearly a year after 
they began work on the algorithms, Arturia was ready for feedback. At the 2002 NAMM show in 
California, Arturia shared an early version of what would later be the Moog Modular V with the 
renowned maker of the original Moog synthesizer, Doctor Bob Moog. 

In seeking insight from sound production experts, such as Dr. Moog, as well as avid synthesizer 
users, Arturia was able to ensure the quality of the instruments they made; so well in fact the Dr. 
Moog himself endorsed the Moog Modular V. The launch of this sound powerhouse was an instant 
success, winning awards from several top magazines, and leading to the development of other 
synth recreations.  

Shortly thereafter, Arturia started receiving many requests from musicians, producers and bands. 
Many of them explained how they were planning to replace their original hardware synthesizers by 
virtual instruments. Artists around the globe were beginning to see the advantages of a software 
alternative to hardware-based synthesizers.  

The CS-80V emulated the legendary Yamaha CS-80, considered by many as “the ultimate 
polyphonic” synthesizer, was launched at the AES 2003 in New York. Imagine some of your favorite 
music from diverse artists such as Keith Emerson or Stevie Wonder, and you will have a mental 
glimpse of the sonic capabilities of the CS-80V. 

Released at the NAMM 2004, the minimoog V is a recreation of the Minimoog, quite possibly the 
most famous synthesizer ever. The original minimoog has been big on the music scene since the 
70’s; still today the Minimoog has a large following for its many sound capabilities. 

The ARP 2600 V was launched at the NAMM 2005 in Anaheim. This is a faithful reproduction of the 
ARP 2600 and is great for just about any sound one might wish to create: everything from drum n’ 
bass stabs to Star Wars’ R2-D2 have been made with the Arp. 

At the Winter NAMM Show 2006, ARTURIA announced the release of its seventh product: the 
Prophet V. This powerful hybrid gives you two instruments in one: it combines the warmth of the 
legendary Prophet 5 programmable analog synth with the unique Vector Synthesis textures of the 
digital Prophet VS. 
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3.1.2. Here and Now 

Analogue Factory brings you the best spectrum of sounds from all of the above instruments in an 
easy to use, no-hassle interface. As you will soon see in exploring the instrument yourself, a single 
instrument gives you your pick from the most complete synthesis sound palette one could ask for. 

If you have never played a real synth, or even if you don’t know what a synthesizer is, it is not 
important; you will be glad to have invested in such a powerful instrument once you hear the 
difference Analog Factory makes in your studio.  

 

3.1.3. TAE® 

TAE®, True Analog Emulation, is Arturia's outstanding technology dedicated to the digital 
reproduction of analog circuits used in vintage synthesizers. 

When implemented in software code, TAE®’s algorithms guarantee authentic emulation of hardware 
specifications. This is why the Analog Factory, and all of Arturia’s virtual synthesizers, do offer an 
unparalleled quality of sound.  

TAE® combines four major advances in the domain of synthesis: 

3.1.3.1. Aliasing-free oscillators 

Standard digital synthesizers produce aliasing in high frequencies, and also when using Pulse Width 
Modulation or FM. 

TAE® allows the production of totally aliasing-free oscillators in all contexts (PWM, FM…), and at no 
extra CPU cost. 

 

Linear frequency spectrum of an existing well-known software synthesizer 

 

Linear frequency spectrum of the ANALOG FACTORY oscillator made with TAE 

3.1.3.2. A better reproduction of analog oscillator waveforms 

The waveforms produced by the oscillators in analog synthesizers are marked by the presence of a 
capacitor in the circuits. The discharge of the capacitor results in a light bend in the original 
waveform (notably for saw tooth, triangular and square waveforms). TAE® allows the reproduction 
of this capacitor discharge. This is the analysis of a waveform from one of the 5 original 

Aliasing 
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instruments that Arturia’s software emulates, and that of the ANALOG FACTORY. They are both 
equally deformed by the low-pass and high-pass filtering. 

 
Temporal representation of a “saw tooth” waveform of an hardware synthesizer 

 
Temporal representation of a “saw tooth” waveform reproduced by TAE 

What’s more, the hardware analog oscillators were unstable. In fact, their waveform varies slightly 
from one period to another. If we add to this the fact that the starting point for each period (in 
Trigger mode) can vary with the temperature and other environmental conditions, we find one of 
the characteristics that contributed to the typical sound of vintage synthesizers.  

TAE® reproduces the instability of oscillators, bringing a fatter and “bigger” sound.  

3.1.3.3. Direct Filter Circuit Modeling 

Due to advances in computer processing power, the ANALOG FACTORY can now employ direct filter 
modeling techniques to achieve unprecedented accuracy in the emulation of a hardware 
synthesizer’s filter. By modeling the operation of the individual hardware components of the filter 
circuit, the warm nuances synonymous with analog sounds are recreated. 

This graph is a frequency domain plot as just a single example of direct circuit modeling in action; 
it shows the generation of harmonics at multiples of the resonant frequency when the filter is in 
self oscillation mode, for both one of Arturia’s virtual instruments and what it is emulating. These 
harmonics are characteristic of hardware synthesizer’s filters and are due to the non-linear 
behavior inherent in its analog circuitry. The harmonics generated add to the richness and warmth 
of the sound produced by the filter. As a result of the direct recreation of this analog circuitry, the 
same characteristics of the sound are present, thus giving the user a truly analog sound. 



ARTURIA – HIPHOP PRODUCER – USER’S MANUAL 29 

 
Comparison of harmonics generated by the filter circuits  

of the ANALOG FACTORY and a hardware synthesizer when in self-oscillation 

3.2. Authorization 

In the bundle box you will find a product registration card, showing a serial number and an 
unlock code. These allow you to register and identify yourself as an Arturia customer, therefore 
being able to authorize all instruments contained in the pack: http://www.arturia.com/login 

 

The Registration Card 

Once you registered your HipHop Producer pack, you are prompted to the activation code for the 
Analog Factory HipHop Edition.  

Copy this code and paste it in the pop-up window that shows when you launch the Analog Factory 
synthesizer: 

 

Activation window 

Once activated, the Analog Factory HipHop Edition main interface shows up: 
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Your synthesizer is now correctly authorized, and ready for growling. 

3.3. Using Analog Factory 

3.3.1. Preferences 

Preferences are set in Analog Factory by clicking on the Analog Factory logo on the virtual 
keyboard. The following options are available: 

SHOW ANIMATION 
Choose to activate or deactivate the animation (keyboard and Preset 
Manager folding).  

SHOW CONTROL 
POPUP WHEN MOUSE 
CLICKS ON CONTROL 

A small popup window appears each time that the mouse clicks on a 
modifiable parameter in order to give information about the parameter 
and modifiable values. Choose ON to activate this preference, or OFF to 
deactivate it. Default is ON. 

SHOW CONTROL 
POPUP WHEN MOUSE 
RESTS ON CONTROL 

A popup window will appear when the mouse is left upon a modifiable 
parameter giving information about the parameter and the modifiable 
values. Choose ON to activate this preference, or OFF to deactivate it. 
Default is ON. 

LCD COLOR 
This function offers a choice between several available 
colors/combinations on the Preset Manager screen.  

3.3.2. Tool Bar 

 
Tool Bar 

The tool bar consists of an ensemble of essential icons for the ANALOG FACTORY organized from 
left to right allowing the user to see/have access to: 

PRESET NAME 
INSTRUMENT 

TYPE 

Name of the current preset, name of the Instrument, and the Type of 
instrument.  

SAVE AS 

Saving presets (sound programming). This function allows the user to save a 
preset which has been modified, including giving it a new name. This new preset 
will be a USER Preset, opposed to a FACTORY Preset (which cannot be modified). 
When one chooses the “Save As” function, a window opens allowing the user to 
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name and classify the new preset according to TYPE and CHARACTERISTICS. 

 So that the foundation of the instrument remain intact, it is not possible to save or delete a 

Factory preset (that comes installed in the software). However, the “Save As” function allows the 
modification and saving of a preset under another name that the user chooses. 

SAVE Permits one to save a USER Preset.  

DELETE You can delete any USER preset with this function. 

IMPORT 

Permits the user to import a document containing the USER presets for Analog 
Factory (allowing you to add presets from your personal collection). The 
document referred to is called “*.afpresets”. To import, click on IMPORT and 

then the local “*.afpresets” document in your computer. If the document being 

imported has the same name as existing presets, the following options will 
appear: Duplicate, Replace or Skip. “Duplicate” leaves two presets with the same 
name listed in the Preset Manager. “Replace” will replace the current preset with 
the same name with that of the one being imported. “Skip” will stop the new 
preset from being imported. 

EXPORT 

Choose this function to export USER Presets. Click on “Export”, choose the 
destination of the “*.afpresets” document which will be created, and give it a 

name. 

 So that the foundation of Analog Factory remains intact, it is not possible to Import/Export 
Factory presets. 

MIDI IN 
Light signaling MIDI activity: will illuminate when a note from an external MIDI 
controller or keyboard is pushed. 

MIDI CH. 

This drop-down menu offers the channel choice from which Analog Factory 
receives MIDI information. Default is OMNI (responds to data on all MIDI 
channels). 

TUNE 
General settings for the tuning of Analog Factory. This allows the user to finely 
tune the general tuning of the instrument. 

VIEW 
Choose the view of the interface. The selection buttons offer the choice to View 
all of Analog Factory, only the Preset manager, or only the Keyboard. 

3.3.3. Using Preset Manager 

Presets account for the various sounds of Analog Factory: there are 250! A preset contains all the 
settings information of the different controllers necessary to reproduce a sound. In Analog Factory, 
there are various ways in which the Presets are classed and filtered in order to simplify preset 
management and find the appropriate sounds for a song; one won’t have to search 250 presets to 
find the desired sound. These filters are listed on the left of the Preset Manager menu and 
presented as follows: Instrument, Type, and Characteristics.  

Let’s take a moment to look at each. 

 
Preset Manager 
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3.3.3.1. Instrument 

“Instrument” refers to one of the 4 instruments from which Analog Factory draws its sound. The 
instruments include: 

• Moog Modular V 

• CS-80 V 

• minimoog V 

• Arp 2600 V 

If, for example, one clicks on CS-80 V, the Preset Manager will provide a list of presets uniquely 
from the CS-80 V. But one can also chose to browse for more than one Instrument; that means the 
user can look for sounds from CS-80 V and ARP2600 V at the same time by selecting both 
instruments in the “Instrument” frame. When no Instruments are selected for preset filtering, then 
the Manager will either automatically list all presets or list presets based on other filters.  

All presets are listed to the immediate right of the filters under Preset Name.  

3.3.3.2. Type 

“Type” refers to instrument type being synthesized. Just as in the above example, one may select 
only “Type” to have access to the list below: 

• Bass 

• Pad 

• Lead 

• EFX (sound effect) 

• FM 

• Brass 

• Percussive 

• Sequence 

• Strings 

• Guitar 

• Organ 

• Piano

As with the Instrument filter, one can choose one or more Types of presets. By selecting only 
BASS, the user will be given a list that contains only bass presets, and if one chooses BASS and 
STRINGS both Types will be provided. 

The user may also search deeper by selecting and combining the different filters. For example, one 
may choose BASS, PAD, and STRINGS under the Type filter and MOOG MODULAR V and ARP2600 V 
in the Instruments filter. The Preset Manager will then offer a list fulfilling only the above criteria.  

3.3.3.3. Characteristics 

To further filter the choices, there is a third filter offered. “Characteristics” allows the user to 
choose presets according to a mood or ambiance. The choices available are as follows: 

• Bright 

• Dark 

• Aggressive 

• Quiet 

• Hard 

• Soft 

• Complex 

• Simple 

• Short 

• Long 

• Bizarre 

• Acid 

• Ambient 

• Digital 

• Ensemble 

• Noise 

• SoundTrack 

• Fun

Once again, these filters can be applied either individually or in any combination that the user 
wishes in order to find the ideal presets. 

3.3.3.4. Entries Found 

This number, found at the bottom right of the Preset Manager, indicates the amount of Presets that 
correspond to a preset search. 
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3.3.3.5. Filter Options 

Above the filters are three buttons: Reset, Favorites, and User. These buttons function as follows: 

RESET 
Removes any filters that the user may have applied to the presets so that a new 
search may be started. 

FAVORITES 

Presents only the favorites that the user has checked in the favorites list. When the 
Favorites Filter Option is selected, then the filters (Instrument, Type, and 
Characteristics) will be applied only to the list of favorites. 

USER 

An abbreviation of USER PRESETS. Since the user can modify and create new 
presets, he may also choose the Filter Option “USER” in order to view and search 
among only the presets created by the user. 

3.3.3.6. Current Preset Information 

Information on the current preset, or an “Identity Card”, is found to the 
right of the Preset Manager.  

An image of the original instrument which the preset is based upon is 
presented along with the following information: 

PRESET The name of the current preset 

INSTRUMENT The name of the virtual instrument 

AUTHOR The name of the sound designer who created the preset 

POLYPHONY This shows the number of available voices for the current preset. 

EDIT PRESET 

If the current preset selected is a USER Preset, it is possible to edit its information. 
By clicking on this option, a window similar to that of the Save As function 
appears. It is possible to change the Preset Name, Type (Bass, Brass, Pad, Lead, 
etc …) and the Characteristics (simply click in the boxes corresponding to the 18 
possible options: Bright, Dark, Aggressive, Quiet, Hard, Soft, etc…). 

 

 
EDIT Preset Window 

3.3.3.7. Organization 

In addition to the Preset Filters that help the user easily search and select among the 250 various 
presets, there are also view options within the Preset Manager that permit the user to choose how 
the presets are listed. 

When the user selects the filter criteria, the list of Presets appears in a vertical column in the 
middle of the screen under: 



ARTURIA – HIPHOP PRODUCER – USER’S MANUAL 34 

PRESET NAME 

By default, the presets will be listed automatically in alphabetical order from A to Z 
under Preset Name. However, if the user prefers, the presets can be arranged on 
the screen according to other criteria in the adjacent columns: 

INSTRUMENT 

In this column, the name of the original instrument that produced the sound is 
offered for each preset. Therefore, it will list among the following instruments: 
minimoog, Moog Modular V, ARP 2600 V, CS-80 V. When the user clicks on the 
title bar labeled Instrument, the columns will reorganize alphabetically under the 
Instrument column.  

TYPE 

In this column, the TYPE of instrument appears corresponding to each preset. By 
clicking at the top of the column on the TYPE title bar, the presets presented will 
be listed alphabetically according to TYPE in the same column. 

CPU 

In this column, the CPU usage rate appears for each preset. By clicking the title 
bar labeled CPU at the top of this column, the presets will be arranged on a scale 
from 1 to 5. 1 represents a weak CPU usage rate while 5 represents a strong CPU 
usage rate.  

FAV 

Favorites permit the user to classify presets according to usage or general 
preference as one does in popular media players. Simply check one’s favorite 
presets and access them by clicking the title bar at the top of the column. One 
may also easily access the Favorites with the Favorites Filter Option. 

3.3.4. Keyboard View 

The Keyboard view of Analog Factory (accessed either by the “Keyboard” or “All” view in the 
toolbar) gives the user access to both the virtual keyboard and all the controls with which the user 
can modify the sound of the presets. We will take a moment now to look at those controls. 

3.3.4.1. Virtual keyboard 

The knob called “LEVEL” controls the general volume of Analog Factory. The more the knob is 
turned to the right the higher the output level is raised. 

The virtual keyboard visually presents 32 keys and allows one to produce the sounds of Analog 
Factory without the need for an external master MIDI keyboard. With the aid of the TRANSPOSE 
function found to the left of the virtual keyboard above the modulation wheels, the user may scroll 
up or down the keyboard for notes in higher or lower ranges than is visually presented.  

 
Virtual Keyboard 
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3.3.4.2. The wheels 

The wheels found on the left side of the virtual keyboard, give the user control over the frequency 
of the sound (“PITCH”) and the modulation rate (“MOD”).  

PITCH BEND 

Wheel controlling the pitch of the tone. When 
pushed in the up direction, the sound “bends” and 
becomes higher in tune. When pushed in the Down 
direction, the sound “bends” and becomes lower in 
tune. 

 

MOD WHEEL Wheel controlling modulation (MIDI controller #1)  

3.3.4.3. Filter 

CUTOFF 

Modifies the cut-off frequency: this filter has the ability to make 
the sound more or less bright by controlling the amount of high 
frequencies 

 RESO 
Modifies the resonance of the filter: the sound becomes more 
“cutting” when the parameter is pushed 

3.3.4.4. LFO 

The LFO, Low Frequency Oscillator, is used as a modulation source for Analog Factory’s sound. It 
allows the user to create variations in a sound parameter to generate diverse effects such as a 
vibrato, “wahwah” effect, etc. The two parameters that may be modulated within the LFO are: 

RATE Knob setting the LFO rate/speed 

 
AMOUNT Knob setting for the amount of LFO modulation 

3.3.4.5. Key Parameters 

The key parameters section will prove to be particularly useful. This section is found in the middle 
of the Keyboard View and labeled with the aforementioned name. 

 
Key parameters 

Each preset offers the four most pertinent parameters unique to that preset. Our sound designers 
have taken the greatest care to assign parameters that will enrich and give depth to the sound of 
each preset. In this way, only the parameters that are the most beneficial when 
modifying/tweaking a given sound are available, facilitating the production process.  

To know which 4 parameters have been selected for each preset, simply drop an eye just above the 
virtual keyboard: 4 information blocks teach you the parameter affected to each controller, with 
their respective colors: 
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3.3.4.6. FX MIX (Effects Mix) 

Analog Factory also carries a simple yet efficient effects section. The two effects, Chorus and Delay, 
are automatically synchronized to the tempo of a piece in the user’s sequencer. If none the less, 
the user wishes to access more advanced effects, they are available in most sequencer programs 
(Cubase, Garage Band, Pro Tools, to name just a few).  

CHORUS 

The Chorus effect permits one to double and detune the sound in 
order to make it deeper and richer. The Chorus MIX controls the 
amount of Chorus applied to the original sound, making it more wet 
or dry. 

 
DELAY 

The Delay carries an echo effect (repetition of the sound) that gives 
space to the tone. The speed of these repetitions is automatically 
synchronized to MIDI tempo (the tempo of a song in the host 
sequencer). The user simply has to adjust the Delay MIX knob to 
control the quantity of the effect. 

3.3.4.7. ADSR faders 

The “ADSR” envelope is composed of four successive sequential periods in the life of a note: Attack 
time, Decay time, Sustain time, and the Release time.  

ATTACK 

Begins when a note is activated. The Attack time may be short 
and dry (as in percussion) or long and ascending (as with a pad 
sound)  

DECAY 
Follows the Attack. The Decay is a period in which the amplitude 
of the sound is reduced to the sustain level.  

SUSTAIN The sustain level of the note, as long as the note is active/held 
 

RELEASE 
The end of the sound. The release can be short or stretch out 
over a longer duration 

Thanks to these 4 faders (A, D, S, and R) you can very simply edit the amplitude curve envelope of 
each sound within Analog Factory. If, for example, you find a sound pleasant but the attack is too 
long, you can use the A fader to reduce it. 

As will be described in the following paragraphs, the diverse parameters of Analog Factory can be 
controlled from an external MIDI keyboard making the manipulation of the instrument much more 
practical and quicker than manipulations with a mouse. It is in this spirit that the instrument was 
created. It is recommended to use Analog Factory with an external MIDI keyboard.  

3.3.4.8. SNAPSHOT Buttons 

The Snapshot buttons are found at the top left hand corner of the Keyboard view. These eight 
buttons allow the user to quickly save any preset being used, along with modifications that may 
have been made to them, for easy access. These 8 snapshots are automatically saved when Analog 
Factory closes and will be automatically available when the program is reopened. 

This feature is especially useful when an artist plays live because these 8 Snapshots can then be 
easily accessed from a MIDI interface. This means that the user can stock 8 favorite presets along 
with any modifications previously made, and have everything needed at the touch of a button on a 
MIDI interface during a live session without referencing the computer screen. 

It can also be useful for comparing modifications to sound in order to choose which fits best into a 
musical production. For example one could store 8 different states of the same preset: first state or 
original, second with the Cutoff applied, third state using the delay, etc… 

 
Snapshot buttons 
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To take a Snapshot, simply Shift+Click on one of the snapshots buttons in order to save the 
preset currently being used. Then, later, to recall the preset along with any modifications that may 
have been made to it, click on the same button. 

If the same Shift+Click operation is done on the same button, then the current Snapshot will be 
replaced without prompting the user. 

3.3.4.9. MIDI control 

Most of the knobs, sliders, and switches on the Analog Factory can be manipulated with external 
MIDI controllers, and this is ideally the way they should be controlled, in order to get a high level of 
usability. Before anything else, the user should make sure that the MIDI device being used is 
correctly connected to the computer, and that the sequencer or the Analog Factory application is 
correctly configured to receive MIDI events coming from the device. 

Every instance of the Analog Factory receives MIDI events transmitted on a given channel. This 
reception channel is defined in a global manner for the synthesizer, either in the sequencer, or in 
the standalone Analog Factory application. On the reception channel, the Analog Factory can 
receive different MIDI controls.  

It is possible to choose a reception control for each knob, which means assigning an external 
controller to a given parameter. For this, one should click on the knob being used while 

holding down the Control key. A configuration window appears and offers the choice of a MIDI 
control number. The user can also click on the “Learn” button and move one of the physical MIDI 
controllers. In this case, the control number will be detected and configured automatically. To 
deactivate the MIDI control of a knob, simply uncheck the “Active” option in the MIDI control 
window.  

 
MIDI assignation of the Chorus controller 

3.4. Modes of Operation  

3.4.1. Stand-alone and MIDI Configuration 

The stand-alone application allows the use of the Analog Factory outside of any host application. 
You can open the instrument from its location in the start menu or on your desktop, and play 
directly with the help of a master MIDI keyboard or external sequencer on a separate computer. 

3.4.1.1. Launching the Stand-alone application 

To launch the Stand-alone application on your PC, go into the menu “Start > Programs > Arturia” 
and choose Analog Factory. 

On a Macintosh, open the folder /Applications/Arturia Analog Factory/ and double click on 

the application icon Analog Factory. 

3.4.1.2. Preferences configuration  

In order to access the preferences window, click on the menu “File > Audio & MIDI Preferences” 
(both Mac OS X and Windows). This window allows you to configure the global preferences of the 
Analog Factory application. These are saved automatically.  
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The preferences window  

AUDIO 
DEVICE 

Here, select the driver corresponding to the sound menu that you wish to use. 

SAMPLE RATE 

Here, choose the sampling frequency among those proposed by your sound menu. 
Note that a higher sampling frequency rate settings will demand increasing 
processor performance from your computer. 

AUDIO 
BUFFER SIZE 

Here, you can configure the optimal audio latency as it relates to performance of 
your sound card. Be careful with this setting, as a latency setting lower than your 
system can support can cause unwanted artifacts in the sound. 

OUTPUT 
CHANNELS 

Select the audio output channel. If the sound menu offers several outgoing 
channels, choose the pair of output channels that you wish to use. 

ACTIVE MIDI 
INPUTS 

Select the MIDI devices you want to use to control the synthesizer. 

3.4.2. Instantiated in Live 

3.4.2.1. Installation 

3.4.2.1.1. Windows 

During installation, the box “VST” must have been selected among the proposed format choices of 
plug-ins. The installer will automatically detect the VST folder of the instruments used by Live. In 
the case of another compatible VST sequencer, such as Cubase, you will have to manually copy the 
plug-in file in the appropriate folder. The direct path to this file is: 

C:\Program\Files\Arturia\Analog Factory\Analog Factory.dll 

3.4.2.1.2. Mac OSX 

The VST plug-in is automatically installed in the folder of the system corresponding to the VST 
instruments: /Library/Audio/Plug-Ins/VST/. The VST plug-in will be usable by all your VST host 

applications.  

3.4.2.2. Instrument use in the VST mode 

Opening the Analog Factory HipHop Edition plug-in is done like any other plug-in, please consult 
the user manual of the host sequencer for more accurate information.  

In Live > Preferences > File Folder, please check that the Audio Unit and VST boxes are active as 
displayed below: 
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Set the VST folder for Ableton live 

3.4.2.2.1. Insert an Instrument Track 

To insert an instrument track, open the left sided folder. All your plug-in devices are listed as 
below. Then, double click on your Instrument will create a MIDI track which include your Analog 
Factory. 

 

List of the plug-in devices 

3.4.2.2.2. Opening the instrument 

To open your instrument, display the Detail view by double clicking on the MIDI track or press 
[Command]+[Alt]+L on Mac, [AltGr]+L on Windows. The detail view shows the device and an 
assignable X–Y control pad. 

 

Live's detail view 

The first button is a On/Off Switch for the VST, the second one is to define the parameters of the 
instrument, and the third is to open the Analog Factory window: 

 

The three buttons 

Ableton Live is able to use your instrument in VST mode and Audio Unit mode if you work on a 
Macintosh. The text above works for both. 
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3.5. End User License Agreement 

Grant of License 

In consideration of payment of the Licensee fee, which is a portion of the price you paid, Arturia, as 
Licensor, grants to you, the Licensee, a nonexclusive right to use this copy of the Analog Factory 
program (hereinafter the “SOFTWARE”) on a single computer at a time. All rights not expressly 
granted to Licensee are reserved to Arturia. 
 
Software Ownership 

As the Licensee you own the disks on which the SOFTWARE is recorded or fixed. Arturia shall retain 
full and complete title to the SOFTWARE recorded on the enclosed disks and all subsequent copies 
of the SOFTWARE, regardless of the media or form on or in which the original disks or copies may 
exist. This License is not a sale of the original SOFTWARE. 
 
Copyright Restrictions 

This SOFTWARE and the accompanying printed or written materials are copyrighted. Unauthorized 
copying of the SOFTWARE, including those instances where the SOFTWARE has been modified, 
merged, or included with other Software, or of the printed or written materials, for any reason, is 
expressly forbidden. Licensee may be held liable for copyright infringement which results from such 
unauthorized copying. 
 
Restrictions on Use 

Licensee may physically transfer the SOFTWARE from one computer to another, provided that the 
SOFTWARE is used on only one computer at any one time. Licensee may not electronically transfer 
the SOFTWARE to multiple computers over a network system. Licensee may not distribute copies of 
the SOFTWARE or accompanying materials to others. Licensee may not modify, adapt, translate, 
reverse engineer, decompile, disassemble, or create derivative works based on the SOFTWARE or 
its accompanying printed or written materials. 
 
Transfer Restrictions 

Licensee shall not assign, rent, lease, sell, sublicense or otherwise transfer the SOFTWARE to 
another party without prior written consent of Arturia. Any party authorized by Arturia to receive 
the SOFTWARE must agree to be bound by the terms and conditions of this Agreement. 
 
Limited Warranty 

Arturia warrants that the disks on which the SOFTWARE is furnished to be free from defects in 
materials and workmanship under normal use for a period of thirty (30) days from the date of 
purchase. Your receipt shall be evidence of the date of purchase. Any implied warranties on the 
SOFTWARE are limited to thirty (30) days from the date of purchase. Some states do not allow 
limitations on duration of an implied warranty, so the above limitation may not apply to you. All 
programs and accompanying materials are provided “as is” without warranty of any kind. The 
complete risk as to the quality and performance of the programs is with you. Should the program 
prove defective, you assume the entire cost of all necessary servicing, repair or correction. 
 
Remedies 

Arturia's entire liability and your exclusive remedy shall be at Arturia's option either (a) return of 
the purchase price or (b) replacement of the disk that does not meet the Limited Warranty and 
which is returned to Arturia with a copy of your receipt. This limited Warranty is void if failure of 
the SOFTWARE has resulted from accident, abuse, modification, or misapplication. Any replacement 
software will be warranted for the remainder of the original warranty period or thirty (30) days, 
whichever is longer. 
 
No other Warranties 

The above warranties are in lieu of all other warranties, expressed or implied, including but not 
limited to, the implied warranties of merchantability and fitness for a particular purpose. No oral or 
written information or advice given by Arturia, its dealers, distributors, agents or employees shall 
create a warranty or in any way increase the scope of this limited warranty. 
 
No Liability for Consequential Damages 
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Neither Arturia nor anyone else involved in the creation, production, or delivery of this product shall 
be liable for any direct, indirect, consequential, or incidental damages arising out of the use of, or 
inability to use this product (including without limitation, damages for loss of business profits, 
business interruption, loss of business information and the like) even if Arturia was previously 
advised of the possibility of such damages. Some states do not allow limitations on the length of an 
implied warranty or the exclusion or limitation of incidental or consequential damages, so the 
above limitation or exclusions may not apply to you. This warranty gives you specific legal rights, 
and you may also have other rights which vary from state to state. 
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4. Lounge Lizard Session 

 
 

 
 

Information in this manual is subject to change without notice and does not represent a commitment on the part of Applied 
Acoustics Systems DVM Inc. The software described in this manual is furnished under a license agreement. The software 
may be used only in accordance of the terms of this license agreement. It is against the law to copy this software on any 
medium except as specifically allowed in the license agreement. No part of this manual may be copied, photocopied, 
reproduced, translated, distributed or converted to any electronic or machine-readable form in whole or in part without prior 
written approval of Applied Acoustics Systems DVM Inc.  
Copyright © 2006 Applied Acoustics Systems DVM Inc. All rights reserved. Printed in Canada.  
Program Copyright © 2006 Applied Acoustics Systems, Inc. All right reserved.  
 
Lounge Lizard EP is a Trademark of Applied Acoustics Systems DVM Inc. Windows 98, 2000, NT, ME, XP and DirectX are 
either trademarks or registered trademarks of Microsoft Corporation. Macintosh, Mac OS, QuickTime and Audio Units are 
registered trademarks of Apple Corporation. VST Instruments and ASIO are trademarks of Steinberg Soft Und Hardware 
GmbH. RTAS is a registered trademarks of Digidesign. Adobe and Acrobat are trademarks of Adobe Systems incorporated. 
All other product and company names are either trademarks or registered trademarks of their respective owner. 
Unauthorized copying, renting or lending of the software is strictly prohibited.  
 

Visit Applied Acoustics Systems DVM Inc. on the World Wide Web at www.applied-acoustics.com 

4.1. Introduction  

The Lounge Lizard Session is a software electric piano based on the classic instruments of the 
seventies (Rhodes, Wurlitzer). This special edition is a simplified version of the well-known A|A|S 
Lounge Lizard EP. Each component of an electric piano has been modeled with A|A|S cutting edge 
physical modeling technology to provide realistic and lively sounds.  

Physical modeling uses the laws of physics to reproduce the behavior of an object. In other words, 
the Lounge Lizard Session solves, in real time, mathematical equations describing how its different 
components function. No sampling or wavetables are used in the Lounge Lizard Session, the sound 
is simply calculated in real time by the CPU according to the values each parameter is receiving.  

Before discussing the synthesizer in more detail, we would like to take this opportunity to thank 
you for choosing an A|A|S product. We sincerely hope that this product will bring you inspiration, 
pleasure and fulfill your creative needs.  
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4.1.1. System requirements  

The following computer configuration is necessary to run the Lounge Lizard Session:  

Mac OS 

• Mac OSX 10.2 (Jaguar) or later.  

• G4 733 MHz Processor  

• 256 MB RAM  

• 1024 x 768 or higher screen resolution  

• MIDI Keyboard (recommended)  

• Internet connection 

• Quicktime 4.0 or later 

Windows 

• Windows 98SE/ME/2000/XP  

• PIII 800 MHz  

• 128 MB RAM  

• 1024 x 768 or higher screen resolution  

• DirectX or ASIO supported sound card 

MIDI Keyboard (recommended) 

Keep in mind that the computational power required by the Lounge Lizard Session depends on the 
number of voices of polyphony and the sampling rate used. These computer configurations will 
enable you to play the factory presets with a reasonable number of voices.  

4.1.2. Installation  

4.1.2.1. Mac OS  

Insert the Lounge Lizard Session program disc into your CD-ROM drive. Open the CD icon once it 
appears on your desktop. Click on the Lounge Lizard Session Install icon and follow the instructions 
of the installer.  

If you purchased this software online, simply double-click on the installer file that you have 
downloaded and follow the instructions of the installer.  

4.1.2.2. Windows  

Insert the Lounge Lizard Session program disc into your CD-ROM drive. Launch Explorer to view 
the content of the CD-ROM and double-click on the installer file to launch the installer.  

If you purchased this software online, simply double-click on the installer file that you have 
downloaded and follow the instructions of the installer.  

4.1.3. Authorization and Registration  

The Lounge Lizard Session uses a proprietary challenge/response copy protection system which 
requires authorization of the product. A challenge key is a long string of capital letters and numbers 
that is generated uniquely for each machine during the registration process. In other words, for 
each machine you install this program on, a different challenge key will be generated by the 
program. The response key is another unique string of capital letters and numbers generated from 
the data encrypted in the challenge key. In order to obtain a response key, you will need to 
connect to the A|A|S website and provide the following information:  

• A valid email address 

• Your product serial number, obtained once registered on your Arturia account (see Chapter 
1.5) 

• The challenge key generated by the program 

Note that it is possible to use the program during 15 days before completing the authorization 
process. This period can be convenient if you are installing the program on a computer which is not 
connected to the internet. After that period, the program will not function unless it is supplied with 
a response key.  
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In the following sections we review the different steps required to generate the challenge keys and 
obtain the response key. The procedure is similar on Windows XP and Mac OS systems.  

4.1.3.1. Step 1: Generating the challenge key  

After launching the installer for the first time, a pop-up window will appear asking you if you wish 
to authorize your product now or later. If you are ready to authorize Lounge Lizard Session now, 
click on the Next button otherwise click on the Authorize Later button. If your computer is 
connected to the internet, we recommend that you authorize your product now.  

 
Figure 1: Choosing to authorize Lounge Lizard Session now or later. 

When you click on the Next button, a second window appears asking you to enter your serial 
number. Type your serial number as it appears on the back of the sleeve of the Lounge Lizard 
Session CD-ROM. If you purchased Lounge Lizard Session online, an email with your serial number 
will have been sent to you at the address which you provided during the purchase process.  

 
Figure 2: Enter your serial number in the pop-up window.  

After entering your serial number, click on the Next button and your challenge key will appear 
automatically in the next pop-up window.  

4.1.3.2. Step 2: Generating the Response key and Registering your product  

If your computer is connected to the internet, click on the link to the A|A|S web server appearing 
in the pop-up window. This will launch your web browser and connect you to the unlock page of the 
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A|A|S web server. Enter your email address, serial number and challenge key in the form as shown 
below and click on the Submit button.  

The next form asks you to provide additional information about yourself including your mailing 
address and phone number. This information will be used to register your product. Note that only a 
valid email address is required to register your product. We nevertheless recommend this 
information be provided to ensure our support team is able to contact you to resolve any future 
support issues, and notify you of product updates promptly. This information is kept completely 
confidential. Registration of your product will entitle you to receive support and download updates 
when available, as well as take advantage of special upgrade prices offered from time to time to 
registered A|A|S users. Note that if you already purchased or registered another A|A|S product, 
the information that you have already supplied under the same email address will appear in the 
form. Feel free to update this information if it is outdated. Click on the Submit button and your 
response key will appear on-screen.  

 
Figure 3: Challenge key appears automatically after entering the serial number. 

 
Figure 4: Enter your registration information on the A|A|S server. 
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Figure 5: Generation of the response key on the A|A|S server. 

If your computer is not connected to the internet, take note of your serial number and challenge 
key and proceed to an internet connected computer. Launch your browser and go to the unlock 
page of the A|A|S website at:  

• http://www.applied-acoustics.com/unlock.htm  

Enter your email address, serial number, and challenge key, and click next. You will then receive 
your response code on-screen as described above.  

4.1.3.3. Step 3: Completing the unlock process  

The response key corresponding to your serial number and challenge key will be printed in your 
browser window. In order to complete the unlock process, copy the response key and paste it into 
the corresponding field of the installer window of Lounge Lizard Session. If you obtained your 
response key from another computer, type the response key by hand in the installer window.  

Click on the Next button and a pop-up window will appear informing you that the authorization 
process has been successful. Click on the Finish button to complete the process and launch Lounge 
Lizard Session.  

 
Figure 6: Final step of the unlock process. Enter your response key in the window. 
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Figure 7: Authorization has been successful. 

You will normally only need to go this process once for a given computer except for some special 
cases. On Windows computers your will need to unlock again if:  

• You change your computer  

• You reformat or upgrade your hard drive  

• You change or upgrade your operating system  

On Mac OS computers, this will only be necessary if:  

• You change your computer  

• You change the motherboard of the computer  

4.1.3.4. Obtaining your response key and registering by fax or over the phone 

Should you not have access to the internet, A|A|S support representatives are available to assist 
you in the unlock and registration process Monday to Friday, 9am to 6pm EST. You may contact us 
by phone at: 

North America Toll-free number: 1-888-441-8277  

Outside North America: 1-514-871-8100 

Fax Number: 1-514-845-1875  

Email: support@applied-acoustics.com 

4.1.4. Getting started  

4.1.4.1. Using Lounge Lizard Session in standalone mode  

The Lounge Lizard Session comes with a wide range of factory presets right out of the box which 
amounts to a huge range of sounds before you have even turned a single knob. As you would 
expect, the best way of coming to grips with the possibilities Lounge Lizard Session offers is simply 
to go through the presets one at a time. We recommend that you first start using the Lounge 
Lizard Session in standalone mode.  

• Windows  

Double-click on the Lounge Lizard Session icon located on your desktop or select Lounge 
Lizard Session from the Start > All Programs > menu.  

• Mac OS X  

Double-click on the Lounge Lizard Session icon located in the Applications folder.  
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Before you start exploring the factory presets, take a moment to set up you audio and MIDI 
configuration as explained below.  

4.1.4.1.1. Audio Configuration  

Audio configuration tools are available from the Audio menu. The Audio Settings function allows 
you to select an audio output device from a list, organized by driver type, of those available on 
your computer. On Windows, if you have ASIO drivers available, these should be selected for 
optimum performance. Multi-channel interfaces will have their outputs listed as stereo pairs.  

Select your sound card port from the list in the Audio Configuration dialog from the Audio > 
Audio Settings… menu.  

For more detailed information on audio configuration, sampling rate selection and latency 
adjustments, please refer to section 4.6.3.  

4.1.4.1.2. MIDI Configuration  

MIDI configuration tools are available from the MIDI menu.  

Select your MIDI input device from the list in the MIDI Configuration window available from the 
MIDI > MIDI Settings… menu.  

For more detailed information on Audio and MIDI configuration, MIDI links and MIDI maps, please 
refer to Chapter 4.6.  

4.1.4.2. Exploring the factory presets  

Factory presets can easily be accessed using the “+” and “−” buttons in the lower left corner of the 
toolbar. These buttons are used to navigate through a list of 128 numbered presets called 
programs. The content of this program list can be viewed by clicking on the � button of the 
toolbar. The number of the current program used and the name of the associated preset appear on 
the right of this button. Programs can also be changed by using the “+” and “−” keys from the 
computer keyboard or by selecting programs directly from the list displayed after clicking clicking 
on the � button.  

Presets can also be accessed using the browser appearing on the left of Lounge Lizard Session. This 
browser is similar to the browser your operating system generates to display the contents of your 
hard disk, or your email program uses to organize your mail and address book. When launching the 
application for the first time, this “tree view” will include a destination folder for imported presets 
as well as a Library folder. To open a folder, click on the “+” symbol on Windows or � symbol on 
Mac OS which will reveal the folder content.  

The preset library is different from the program list and can be viewed as a repository containing all 
the presets available to the application. Presets are loaded into the synthesis engine by copying 
them from the library into the program list. To load a preset, double-click on a preset icon (blue 
knob) or preset name. This will insert the preset into the program list at the position of the current 
program. You can also use the arrow keys on the computer keyboard in order to navigate in the 
preset list and then the Enter key to load a preset. For additional information on presets and 
programs, please refer to Chapter 4.2 of this manual.  

4.1.4.3. Using MIDI Links 

Every parameter on the Lounge Lizard Session interface can be linked to an external MIDI 
controller. To assign a MIDI Link, right-click (control-click on Mac) on a control (knob, button or 
slider) and a contextual menu will appear. Select Learn MIDI Link and move a knob or slider on 
your MIDI controller to activate the link. To deactivate the link, right-click (control-click on Mac) on 
the control and choose the Forget MIDI Link command. Refer to section 4.6.2 for more details on 
MIDI links.  
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4.1.4.4. Using MIDI program changes  

The synthesizer responds to MIDI program changes. When a program change is received, the 
current program is changed to the program having the same number as that of the program 
change message received by the application.  

4.1.4.5. Using Lounge Lizard Session as a Plug-in  

The Lounge Lizard Session integrates seamlessly into the industry’s most popular multi-track 
recording and sequencing environments as a virtual instrument plug-in. The Lounge Lizard Session 
works as any other plug-in in these environments so we recommend that you refer to your 
sequencer documentation in case you have problems running the Lounge Lizard Session as a plug-
in.  

4.1.5. Getting help  

A|A|S technical support representatives are on hand from Monday to Friday, 9am to 6pm EST. 
Whether you have a question on Lounge Lizard Session, or need a hand getting it up and running 
as a plug-in in your favorite sequencer, we are here to help. Contact us by phone, fax, or email at:  

North America Toll Free: 1-888-441-8277  

Worldwide: 1-514-871-8100  

Fax: 1-514-845-1875  

Email: support@applied-acoustics.com  

Our online support pages contain downloads of the most recent product updates, and answers to 
frequently asked questions on all A|A|S products. The support pages are located at:  

• http://www.applied-acoustics.com/faq.htm  

4.1.6. Forum and User Library  

The A|A|S community site contains the Lounge Lizard Session user forum, a place to meet other 
users and get answers to your questions. The community site also contains an exchange area 
where you will find presets for your A|A|S products created by other users and where you can 
make your own creations available to other users.  

• http://community.applied-acoustics.com/php/community/ 
• http://community.applied-acoustics.com/php/forum/ 

4.1.7. About this manual  

In the next chapter, the use of presets and the browser are described in detail. Chapter 4.3 
describes the general architecture of Lounge Lizard Session. In Chapter 4.4, the different modules 
and controls are reviewed in detail. Chapter 4.5 describes the different functionalities available 
from the toolbar while Chapter 4.6 explains the different functionalities related to Audio and MIDI 
and their settings. General issues involved in the use of Lounge Lizard Session as a plug-in in 
different host sequencers is covered in Chapter 4.7. Finally a list of available commands and 
shortcuts is given in Chapter 4.8.  

4.2. Presets and MIDI maps  

Lounge Lizard Session comes with several factory presets covering a wide range of sounds. This 
collection of presets lets you play and familiarize yourself with this synthesizer without having to 
tweak a single knob. Soon, however, you will be experimenting and creating your own sounds and 
projects that you will need to archive or exchange with other users. You may also want to control 
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the parameters of Lounge Lizard Session with a specific MIDI controller. In this chapter, we will 
review the management of presets and MIDI maps.  

4.2.1. Presets  

There are two concepts involved in the management of presets, the preset library and programs.  

4.2.1.1. The Preset Library  

The preset library contains the factory presets, modified versions of 
the factory presets you might have made or any other new presets 
you might have saved. The library may also contain imported presets 
as well as MIDI maps as explained in Section 4.2.6 and 4.2.7. In 
other words, the preset library is a repository of all the presets and 
MIDI maps available to Lounge Lizard Session.  

All the operations on the preset library are conveniently managed 
with the help of the Lounge Lizard Session browser, similar to those 
found in most email programs which use a hierarchical tree structure 
and a visually intuitive, drag and drop approach. To explore the 
different presets available in the library, open the different folders by 
clicking on the “+” icon Windows or � symbol on Mac OS to the left of 
folders. Each preset is represented by a blue knob icon followed by its 
name.  

4.2.1.2. The Program list  

Presets are loaded into the synthesis engine of Lounge Lizard Session 
from a list of 128 numbered presets called programs. The name of the 
current program and its number are displayed in the left of the toolbar at the top of the application 
window. The entire list of programs can be viewed by clicking on the � button left of the program 
number.  

It is important to note that presets in the program list and in the preset library are stored in 
different locations. They are in fact different copies of the same presets which may, as explained 
below, differ even if they share the same name. The version of a preset available in the program 
list should be viewed as temporary or as a “working copy” of the preset whereas the version in the 
library should be viewed as permanent or as the “reference version”.  

When you start the application for the first time, the program list contains a selection of presets 
from the factory preset library. At that point, the presets in the program list are identical to their 
version in the library.  

4.2.2. Playing and Changing Presets  

Presets are always played from the program list. The name of the current program, in other words 
the one currently loaded in the synthesis engine, as well as its number are displayed in the left part 
of the toolbar. Its number and name are also preceded by a check mark in the program list. The 
current program can be changed in different ways:  

• Scroll up or down in the program list by clicking on the “+” and “−” buttons located on the 
left of the program name or use the “+” and “−” keys from the computer keyboard,  

• Display the content of the program list by clicking on the � button and select a program by 
clicking on its name.  

• Use the Switch to Program command from the Programs menu and enter a specific program 
number. This command can also be activated by using the Ctrl-P/Apple-P keyboard shortcut.  

• Send MIDI program changes from your MIDI controller. Lounge Lizard Session will load the 
program having the same number as the program change number received by the 
application.  
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A Preset can also be loaded from the preset library. It is then stored in the current program 
replacing the preset that was already stored in this location. It then becomes immediately available 
to the synthesis engine. Different options are available to load a preset from the preset library into 
the current program:  

• In the browser, double-click on a preset icon.  

• Drag and drop presets from the browser onto the Lounge Lizard Session interface.  

• Select a preset by clicking on its icon and use the Enter key from the computer keyboard. 
Once a preset has been selected in the library, it is possible to navigate in the library using 
the Arrow keys from the computer keyboard. A preset is selected when its name is 
highlighted.  

• Select a preset and use the Open Preset command from the File menu or the Ctrl-O/Apple-O 
keyboard shortcut.  

Note that when a preset is loaded from the preset library to the list of programs, the program 
name displayed in the toolbar changes but not its number. This indicates that the current program 
number used by the synthesis engine is still the same but that the preset corresponding to that 
program has changed. The 128 programs can therefore be customized by selecting different 
program numbers (by using the “+” and “−” buttons from the toolbar or selecting programs from 
the program list) and loading presets from the library.  

4.2.3. Editing and Saving Presets  

Moving the different controls on the Lounge Lizard Session interface modifies the preset loaded in 
the current program. As soon as the current program is modified, the preset icon located on the 
left of the program name in the toolbar changes color and a “*” sign is appended to its name in the 
program list. In this state, the preset loaded in the current program is different from its original 
version stored in the preset library even if they share the same name. If you wish to keep a 
permanent copy of the modifications, you must save this new version in the preset library.  

• To save the new version in the preset library, use the Save Preset command from the File 
menu or the Ctrl-S/Apple-S shortcut. Be careful, however, as using this command will 
overwrite the original preset. If you are not certain of which preset will be overwritten in the 
library, first use the Locate Program in Browser command from the Programs menu or 
the Ctrl-L/Apple-L shortcut in order to locate it in the browser.  

• To create a new preset, use the Save Preset As command from the File menu. A window 
will appear asking for a name for the new preset. Once the preset is saved using this 
command, a new preset icon will appear in the browser directly under the Library folder.  

• To create a new preset, it is also possible to rename the program using the Rename 

Current Program from the MIDI menu (or the Ctrl-R/Apple-R keyboard shortcut) and use 
the Save Preset or Save Preset As commands.  

When editing presets, it is very helpful to go back and forth between the different stages of your 
modifications and adjustments. To move back step by step through every modification that was 
applied to a preset, use the Undo command from the Edit menu or the Ctrl-Z/Apple-Z shortcut. 
Once the Undo command has been used, it is also possible to move up again through the 
modifications by using the Redo command from the Edit menu or the Ctrl-Y/Apple-Y command. 
The number of Undo levels is unlimited and that this command is effective on any control of the 
interface but not on the different Save commands.  

Once a preset has been modified, it is also possible to move back and forth between the current 
state of the preset in the program list and its original version archived in the preset library. To hear 
the original preset, simply click on the Compare button at the top of the interface or use the 
Compare command from the Edit menu. Once this button has been pressed, the original settings 
of the preset are loaded. In this mode, the graphical interface is frozen and it is therefore not 
possible to modify the preset. To further modify the preset, click on the Compare button again or 
uncheck the Compare command in the Edit menu to revert to the modified version of the preset 
and unfreeze the interface. To reload the original version, use the Locate Preset in Browser 

command from the View menu, or the Ctrl-L/Apple-L shortcut and double click on its icon in order 
to reload this version into the current program.  
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Lounge Lizard Session will make sure that you do not loose modifications to a preset. In the case 
where a program holds a modified version of a preset and when trying to load a new preset from 
the library into this program, the application will ask you if you want to save the modified preset in 
the library. This behavior might not always be convenient and it is possible to deactivate it by 
deselecting the Ask to save preset before opening another option in the Preferences 
command from the Edit menu.  

4.2.4. Saving the Program List  

When you open Lounge Lizard Session, the application always loads the same program list. This 
implies that, by default, the program list will always contain the same presets when you open the 
application and that your modifications to presets will be lost unless they have been saved in the 
preset library.  

• To save the current list of programs and replace the default program list, use the Save All 
Programs command from the Programs menu.  

This command is helpful if you wish to modify the program list or if you wish to restart the 
application in exactly the same state as when you left it.  

Note that this operation is not necessary when using Lounge Lizard Session as a plug-in in a host 
sequencer as the program list is always saved with a project. The default program list will be 
loaded only if a new project is started or if a new instance of Lounge Lizard Session is opened 
within a project.  

4.2.5. Organizing the Preset Library  

4.2.5.1. Creating Folders  

Sub-folders can be created by first selecting a folder by clicking on it and using the New Folder 

command from File menu.  

4.2.5.2. Copying and Moving Presets and folders  

Presets and folders can be copied and moved from one location to another. First select an item by 
clicking on its icon and use the Copy command from the Edit menu (Ctrl-C/Apple-C shortcut) in 
order to copy it. Then click on the destination folder and use the Paste command from the Edit 
menu (Ctrl-V/Apple-V shortcut) in order to paste it. Groups of items can be copied and pasted at 
the same time. In order to select many items at once, click on different icons while keeping the 
Control/Apple key depressed. Alternatively to select, within a folder, all the presets located 
between two presets, click on the first one and then on the second one while keeping the Shift key 
depressed. Once a group of items has been selected, use the Copy and Paste functions as 
explained above.  

4.2.5.3. Renaming Presets and folders  

On Windows systems, to rename a preset or folder, click a first time on the corresponding icon in 
the browser in order to select it. Then click a second time to enter in name edition mode. Note that 
this sequence of operation is different from double-clicking on the icon which loads the preset in 
the case of a preset icon or opens a folder in the case of a folder icon. In other words, there must 
be a pause between the two clicks.  

On Mac systems, first select the item to be renamed and the use the Rename command from the 
Edit menu. It is also possible to Ctrl-click on the selected item and then choose the Rename 

command.  
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4.2.5.4. Deleting Presets and Folders  

To delete a preset or folder, first select it by clicking on its icon in the browser, then use the Delete 
command from the Edit menu or use the Del key from the computer keyboard. In order to select 
and then delete many items at once, click on different icons while keeping the Control/Apple key 
depressed. Alternatively to select, within a folder, all the presets located between two presets, click 
on the first one and then on the second one while keeping the Shift key depressed. Once the group 
of items has been selected, use the Delete function as explained above.  

4.2.5.5. Documenting Presets  

It is possible to document a preset and view related information. To view or edit information on a 
preset, first select it in the browser and choose the. Preset Info command from the Edit menu or 
use the Ctrl-I/Apple-I shortcut. It is also possible to right-click/control-click on the preset icon and 
choose the Preset Info command. Information on a preset includes the author’s name, copyright 
notice, date of creation, last modification date and a text description.  

4.2.5.6. Locating a Preset in the Browser  

It might sometimes be helpful to locate in the preset library the preset currently being played or in 
other words, that corresponding to the current program. To rapidly locate the current preset in the 
browser, use the Locate Program in Browser command from the Programs menu or the Ctrl-
L/Apple-L shortcut. The Locate command will automatically expand the folder containing the 
currently used preset and select the preset.  

4.2.5.7. Resizing the Browser  

In standalone mode, the browser can be resized. In order to change the size of the browser, 
position the mouse cursor on the line separating the browser from the Lounge Lizard Session 
control panel. When the cursor changes to a double-headed arrow, click-hold and move the mouse 
to the left or right as desired. In order to hide the browser completely, move the double-headed 
arrow cursor fully to the left. Note that when Lounge Lizard Session is used as a plug-in, the 
browser size is fixed and can not be modified.  

4.2.6. MIDI maps  

MIDI maps containing information about MIDI links between the MIDI controllers and the Lounge 
Lizard Session interface can easily be created as will be explained in Section 4.6.2. MIDI maps are 
represented in the browser with a MIDI connector icon. MIDI maps are treated exactly the same 
way as presets in the browser and are saved using the Save MIDI Links or Save MIDI Links As 
commands from the File menu.  

4.2.7. Exporting and Importing Presets and MIDI maps  

The Import and Export commands, found in the File drop down menu, allow one to easily 
exchange presets and MIDI maps with other Lounge Lizard Session users. This feature can also be 
used to decrease the number of elements in the browser by archiving older or rarely used ones 
elsewhere, on CD-R, or a second hard disk for example. Files containing Lounge Lizard Session 
presets and MIDI maps are equivalent in size to short text file, making it easy to send presets to 
other users via email.  

To export a folder, a group of folders, presets or MIDI maps within a folder, select the elements to 
export in the browser and use the Export command from the File menu. When the Export window 
appears, choose a file name and a destination location on your hard disk. Lounge Lizard Session 
export files will be saved with an “lls” extension.  

Importing presets and MIDI maps is just as easy. Simply click on the Import command from the 
File drop down menu, and select the file to import. A new folder will then appear under the 
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Imports directory in the browser, containing all of the files contained within the imported package. 
These can then be dragged and dropped to a new folder, or remain in the Imports directory.  

4.2.8. Backuping Presets and MIDI maps  

There are basically two ways to backup your presets and MIDI maps: exportation and database 
backup. The database backup is more efficient when there is a large number of elements to 
backup.  

The exportation method consists in using the Export command from the File menu as explained in 
section 4.2.7. Once you have exported the elements you wish to archive, just save the export 
file(s) to your usual backup location or medium.  

The second backup method will enable you to archive the entire material present in the browser. 
The content of the browser, including presets, MIDI maps and folders is saved into a database file. 
This second backup method simply consists in archiving this file. The database file location is 
different whether you are working on a Mac OS or Windows system.  

• On Windows systems:  

C:\Documents and Settings\<user>\Application Data\Applied Acoustics Systems\Lounge Lizard Session 3 

• On Mac OS systems: 

<user>/Library/Application Support/Applied Acoustics Systems/Lounge Lizard Session 3  

The name of the database file is LoungeLizardSession.tdb. In order to archive your database, 

just copy this file to your usual backup location or medium. In order to restore a database, replace 
the version of the LoungeLizardSession.tdb file with a previously archived one. It is also possible 

to synchronize different systems by copying this file on different computers where Lounge Lizard 
Session is installed.  

4.2.9. Restoring the Factory Presets and MIDI Links 

If necessary, it is possible to restore the original factory library and program list by using the 
Restore Factory Library from the File menu. This operation makes a backup of your current 
database file in the preset database folder as explained in Section 4.2.8 and creates a new preset 
database containing only the factory presets and MIDI maps. The next time you open Lounge 
Lizard Session, both the browser and the program list will be in exactly the same state as when you 
first installed the application.  

Note that restoring the factory library should be done with caution as you will loose all the work 
you might have saved into the library and that this operation can not be undone easily. If you wish 
to recuperate a certain number of presets and MIDI maps after restoring the factory library, we 
recommend that you first export all the material you wish to keep using the Export command as 
explained in Section 4.2.7. After re-installation of the factory library, you will easily be able to re-
import this material using the Import command.  

If you forgot to export material before restoring the factory library or if you wish to bring back the 
preset library to its state before restoring the factory library, it is still possible to recover material 
from the backup file of the preset database which was created automatically when restoring the 
factory library as explained in Section 4.2.8. This method should be considered as a last resort, 
however, as recovering material from this backup file will remove the factory library which you 
have just installed and force you to redo the operation. Using the Export command before restoring 
the factory library is much simpler.  

Note that the restore of the factory library is actually performed the next time you re-open the 
application. It is still possible to cancel this operation before exiting the application by using the 
Cancel Library Restore command from the File menu.  
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4.3. General organization of Lounge Lizard Session  

The graphical interface of the synthesizer is shown in Figure 8. One can choose from a selection of 
4 different pianos and apply different effects to the sound. The effect section includes a Tremolo 

module, a Drive module, a Multi-Effect module and a reverb module. A master level control and 
level meters appear on the lower right corner of the interface.  

 
Figure 8: Interface of the Lounge Lizard Session. 

4.3.1. MIDI LED  

The red MIDI LED toggles when a MIDI signal is received by the Lounge Lizard Session. This is very 
useful to see if Lounge Lizard Session is receiving MIDI signal from your keyboard or other 
controllers. If the LED does not blink when you play your keyboard, check your connections and the 
transmit/receive channels you are using or the MIDI settings of Lounge Lizard Session as explained 
in Section 4.6.2.  

4.3.2. MIDI Channel Combo Box  

Displays the current MIDI channel on which Lounge Lizard Session is receiving MIDI information. 
The channel can be adjusted with the drop down menu from the combo box. In omni mode, Lounge 
Lizard Session responds to all MIDI events from all channels. Note that in this configuration, MIDI 
links from different controllers having the same controller number but different channel numbers 
become equivalent.  

4.3.3. Polyphony Combo Box  

Displays the number of voices of polyphony (2 to 32). The number of voices can be adjusted with 
the drop down menu from the combo box.  

4.3.4. General Functioning of an Electric Piano  

The electric piano was invented by Harold Rhodes (1910-2000) during the forties when he was in 
the army. The first instruments he built were made of aircraft pieces and were intended to 
entertain army servicemen. It became a very popular instrument in jazz and rock and its warm 
tone still appears in about all new musical styles these days.  

The mechanism of the electric piano is, in fact, quite simple and is illustrated in Figure 9. A note 
played on the keyboard activates a hammer that hits a fork. The sound of that fork is then 
amplified by a magnetic coil pick up and sent to the output, very much like an electric guitar. The 
fork is made of two parts: the tine and the tone bar. The tine bar is where the mallet hits the fork.  

The Lounge Lizard synthesis engine faithfully reproduces the functioning and interaction of these 
components taking into account their physical and geometrical properties. In the original version of 
the Lounge Lizard EP, the user interface enables one to adjust these properties and get a wide 
variety of tone colors. In this Session edition, these parameters have been adjusted for you in 
order to model different types of pianos which can be selected from the Piano module.  
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Figure 9: Geometry of an electric piano and corresponding elements on the Lounge Lizard EP interface.  

Note that this simplified Lounge Lizard Session edition, these interface controls are not accessible. 

4.4. Parameters  

4.4.1. General Functioning of the Interface  

4.4.1.1. Tweaking Knobs  

All the knobs on the interface are selected by clicking on them. Once selected, they can be 
controlled in different ways depending on the effect you want to achieve.  

• For coarse adjustment click-hold on a knob and drag the mouse upwards or downwards to 
move it clockwise or counter-clockwise.  

• For fine adjustment, use the left or down arrow of the computer keyboard to move the knob 
counterclockwise and the right or up arrow to move it clockwise. The Page Up and Page 
Down keys give the same result with slightly faster action. Note that this may not work in 
certain plug-in formats.  

• To move a control to a given position, place the mouse at this position and Shift-
click/Option-click. To reach this position slowly, do the same, but use the middle button of 
the mouse (Windows only).  

• Knobs with a green LED above can be moved directly to their center position by clicking on 
the LED.  

Remember that the keyboard shortcuts affect only the most recently selected control. The value of 
the control currently selected is displayed on the toolbar at the top of the Lounge Lizard Session 
window. The number displayed on the counter is a value corresponding to the setting of the control 
currently selected.  

4.4.1.2. Buttons  

Buttons are switched on or off by clicking on them. The value appearing in the toolbar when a 
button is selected represents the state associated with the position of the button.  

4.4.1.3. Drop-down menus and Displays  

Clicking on a display with a small down-pointing triangle on its right, such as in the Reverb 
module, reveals a drop-down menu with a set of possible settings for the control. Adjustment of 
the control is obtained by clicking on a selection or using the up and down arrows and the Enter 
key of the computer keyboard.  
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4.4.2. The Piano Module  

The Piano module is used to select the type of piano which will be played. A 
selection of 4 different instruments is available, three Rhodes-like pianos and 
a Wurlitzer-like piano. Switching from one instrument to the other is achieved 
by changing the position of the selector knob.  

The reference pitch of the keyboard can be adjusted with the Tune knob. 
When in its center position (green LED on), the reference note of the 
keyboard is A4 set at 440 Hz. Turning this knob counter-clockwise will lower 
the pitch of this reference note while turning it to the clockwise will increase 
it. Note that the pitch knob can be set directly to its center position by clicking on the green LED.  

4.4.3. The Tremolo Module  

The Tremolo module, introduces low frequency amplitude modulation, or tremolo, 
in the sound. This is an effect extensively used with electric pianos. The effect is 
switched on or off by clicking on the green LED in the upper right corner of the 
module.  

The stereo button is used to determine if the tremolo is mono or stereo. When the 
button is depressed, the tremolo is on and in stereo mode. In this mode, the 
sound bounces with a 180 degrees phase from left to right. When the button is its 
off position, the tremolo is in mono mode and is the same on the left and right 
channels.  

The Depth is used to set the amount of modulation in the amplitude of the signal. In its leftmost 
position, the amplitude is not modulated and turning the knob clockwise gradually increases the 
amplitude of the modulation.  

The Speed knob controls the frequency of the modulation. Turning the knob clockwise increases 
this frequency and results in a faster modulation rate.  

4.4.4. Damper  

Although it is not visible on its interface, the Lounge Lizard Session engine includes a damper 
module which simulates the production of noise when dampers are raised from or applied on the 
fork when a key is depressed or released. This gives a more realistic and lively sound. This 
Damper module responds to the sustain pedal signal via the Damper MIDI Control Change 
message (CC#64). In order for Lounge Lizard Session to respond to a sustain pedal, simply set 
your synth or MIDI controller to send its sustain pedal signal via this MIDI Control Change 
message.  

4.4.5. The Drive Module 

The Drive module implements a simple distortion or overdrive effect such as that found 
in distortion pedals for example.  

The Amount knob is a gain control used to adjust the level of distortion applied to the 
the signal. In its leftmost position, almost no distortion is applied to the signal and 
turning the knob clockwise increased the amount of distortion applied to the signal. The 
effect is switched on or off by clicking on the green LED in the upper right corner of the 
module.  

4.4.6. The Effect Module  

Lounge Lizard Session is equipped with a configurable Effect module. Effects are 
selected using the drop-down menu. The effect list includes chorus, flanger, 
vibrato, digital delay, ping pong delay, tape delay, phaser, auto wah and wah 



ARTURIA – HIPHOP PRODUCER – USER’S MANUAL 58 

wah. All the effects share the same interface except for the labels under the control knobs which 
vary depending on the effect chosen. This module is switched on or off by clicking on the green LED 
in the upper right corner of the module.  

4.4.7. Chorus 

The chorus effects can be controlled with the two knobs appearing at the bottom of the module. 
The Depth knob is used to control the amplitude of the effect while the Rate knob is used to fix the 
modulation frequency of the effect.  

4.4.7.1. Flanger  

The flanger effects is controlled with the three knobs appearing at the bottom of the module. The 
Depth knob is used to control the amplitude of the effect while the Rate knob is used to fix the 
modulation frequency of the effect.  

4.4.7.2. Delay  

The Effect module includes 3 different types of delay effects: Ping Pong, Digital and Tape Delay. 
The Digital delay consists in a standard delay line with feedback. The tape delay is similar but also 
includes a low-pass filtering effect in order to simulate the attenuation of high frequencies in analog 
tape delays. The Ping Pong delay is based on two delay lines resulting in a signal traveling from one 
channel to the other, each time attenuated by a coefficient.  

The Feedback knob is used to adjust the amount of signal re-injected into the delay lines or in 
other word the amount of feedback introduced in the line. In its leftmost position, there is no signal 
re-introduced and the effect module only delays the input signal. Turning this knob clockwise 
increases the amount of signal reflected back at the end of the line. Finally the Time knob controls 
the length of the delay lines and therefore the delay between echoes.  

4.4.7.3. Phaser  

The “phasing” effect colors a signal by removing frequency bands from its spectrum. The effect is 
obtained by changing the phase of the incoming signal and adding this new signal to the original.  

The Depth knob is used to control the amplitude of the effect while the Rate knob is used to fix the 
modulation frequency of the effect.  

4.4.7.4. Wah  

The Effect module includes 2 different types of wah effects: wah wah, and auto wah. Both of them 
are based on a specially designed bandpass filter with a 12 dB/oct slope. In the wah wah effect, the 
center frequency of the bandpass filter varies at a certain rate. In the case of the auto-wah, the 
variations of the center frequency is controlled by the amplitude envelope of the incoming signal.  

The Depth knob controls the excursion of the center frequency of the filter. Turning this knob 
clockwise increases the excursion of the center frequency.  

Finally, the Rate knob controls the frequency or rate of the modulation of the center frequency of 
the filter. In the case of the Wah Wah effect, turning this knob clockwise increases the rate of the 
modulation. In the case of the Auto Wah filter, this knob controls the time constant of the envelope 
follower. Turning this knob clockwise decreases the time constant, or in other words the reaction 
time, of the envelope follower.  

4.4.8. Reverb  

The Reverb module is used to recreate the effect of reflections of sound on the 
walls of a room or hall. These reflections add space to the sound and make it 
warmer, deeper, as well as more realistic since we always listen to instruments in 
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a room and thus with a room effect. The Reverb module is switched on or off by clicking on the 
green LED in the upper right corner of the module.  

The Reverb drop down menu is used to choose between different reverb algorithms representing 
different types of rooms or halls. Each algorithm can be adjusted with the knobs located at the 
bottom of the module. The Mix knob is used to set the relative amount of “dry” and “wet” signal 
which is related to the proximity of the sound source. The Decay is used to control the 
reverberation time of the room.  

4.5. Toolbar  

The toolbar at the top of the Lounge Lizard Session interface allows you to monitor important 
information related to your current set-up.  

 

4.5.1. Program Display  

Displays the number and name of the program currently loaded in the synthesis engine. The + and 
− buttons on the left of the program number, or alternatively the + and − keys on the computer 
keyboard, are used to navigate upwards and downwards in the program list. The complete list of 
128 programs can be viewed by using the � button located on the left of the program number. 
When the preset associated with the current program is different from the version saved in the 
preset library, the preset icon to the left of the buttons changes color in order to indicate that 
saving is necessary in order not to lose the changes that have been applied.  

4.5.2.  MIDI map  

Displays the name of the currently opened MIDI map. For more information on MIDI maps, please 
refer to Section 4.6.2.  

4.5.3.  CPU meter  

Displays the percentage of the total CPU resources currently used by Lounge Lizard Session.  

4.5.4.  Value Display  

Displays the value of the currently selected control on the interface. The values range from 0 to 
127 for knobs and 0 or 1 for buttons depending on whether they are in their on or off position. For 
some controls, the value is displayed in the appropriate units.  

4.6. Audio and MIDI Settings  

This chapter explains how to select the audio and MIDI devices used by Lounge Lizard Session as 
well as how to create and edit MIDI links and MIDI maps. When referring to commands that are 
different on Windows and Mac OS systems, the commands are listed in the following order: 
Windows command/Mac OS command.  
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4.6.1.  Audio Settings  

4.6.1.1.  Selecting an Audio Device  

To select the audio device used by Lounge Lizard Session:  

• Go to the Audio menu and choose the Audio Settings options. A list of the audio devices 
installed on your computer will appear in the Audio Configuration window.  

• Click on the audio device you wish to use and click on the OK button.  

4.6.1.2. Audio Control Panel  

To launch the audio configuration panel, choose Audio Control Panel under the Audio menu. This 
command allows you to select the bit depth sample rate (22.05, 44.1, 48, or 96 kHz) and buffer 
size, which affects how quickly Lounge Lizard Session responds to the control information it 
receives. The smaller the buffer size, the shorter the latency, and vice versa.  

On Windows systems using ASIO drivers, this command opens the control panel provided with the 
driver and the content of the dialog depends on the driver. Some sound cards also require that you 
close all programs before making changes to the buffer size or sampling rate. If you discover this is 
the case with your sound card, please refer to the manufacturer’s documentation for details on 
configuring it for optimum performance. Most sound card manufacturers also update their drivers 
regularly. It is strongly recommended that you visit your sound card manufacturer’s website 
regularly to ensure you are using the most up to date drivers and support software.  

On Mac OS systems, this command launches the Audio MIDI Setup configuration application.  

4.6.2. MIDI Settings  

4.6.2.1. Selecting a MIDI Device 

To select the MIDI device used by Lounge Lizard Session:  

• Go to the MIDI menu and choose the MIDI Settings option. A list of the MIDI devices 
installed on your computer will appear in the MIDI Configuration window.  

• Select the MIDI device you want to use and click on the OK button.  

4.6.2.2. Creating MIDI Links  

Every control on the Lounge Lizard Session interface can be manipulated by an external MIDI 
controller. In most cases this is much more convenient than using the mouse, especially if you 
want to move many controllers at once. For example, you can map the motion of a knob on the 
interface to a real knob on a knob box or to the modulation wheel from your keyboard. As you use 
the specified MIDI controllers, you will see the controls move on the Lounge Lizard Session 
interface just as if you had used the mouse.  

To assign a MIDI link to a controller:  

• On the interface, right-click/Control-click on a control (knob, button), a contextual menu 
appears. Select Learn MIDI Link.  

• Move a knob or slider on your MIDI controller (this can be a keyboard, a knob box, or any 
device that sends MIDI). This will link the control of the Lounge Lizard Session to the MIDI 
controller you just moved.  

MIDI links can also be created by right-clicking/Control-clicking on a control and choosing the Add 
MIDI Link command which will open the Add MIDI Link window.  
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4.6.2.3. Editing MIDI Links  

MIDI links can be edited in the MIDI Links window, which lists all the currently available MIDI links.  

• To edit the MIDI link, right-click/Control-click again on the control and choose Edit MIDI 
Link to open the MIDI links window. You can also use the Edit MIDI Link command from 
the MIDI menu.  

• Click on the MIDI link you wish to modify and then on the Edit button to launch the EDIT 
MIDI Link window.  

• Specify the MIDI controller number and MIDI channel of the physical controller you wish to 
link to the parameter in the corresponding drop-down menus.  

• You can also adjust the Minimum Value and Maximum Value of the controller, which are 
used to limit the range of MIDI controllers. The Minimum Value slider is used to determine 
the position on the Lounge Lizard Session control which corresponds to the minimum value 
sent by the MIDI controller; the Maximum Value slider determines the position which 
corresponds to the maximum value sent by the MIDI controller. The leftmost position of the 
slider corresponds to the Lounge Lizard Session control minimum position (left position for a 
knob) while the rightmost position of the slider corresponds to the Lounge Lizard Session 
control maximum position (right position for a knob).  

• Note that the range of a knob can be inverted by setting the value of Maximum Value to a 
smaller value than that of Minimum Value.  

• Click on the OK button and the link appears in the list of controllers linked to the control.  

• Click on the OK button again to confirm the change and to leave the MIDI Links window.  

• Note that the Minimum Value and Maximum Value of a MIDI link can also be set by 
right/control clicking on the corresponding control and selecting the Set MIDI Link 
Minimum Value or Set MIDI Link Maximum Value command. The value corresponding 
to the control position will then be saved as the minimum or maximum value of the MIDI 
link.  

4.6.2.4. Deleting MIDI Links  

To remove a MIDI link, right-click/Control-click again on the control and choose Forget MIDI Link 
or choose the Forget MIDI Link command from the MIDI menu.  

MIDI links can also be removed from the MIDI Links window by clicking on the MIDI link to be 
removed to select it, then by clicking on the Remove button and the OK button to confirm the 
change.  

4.6.2.5. Creating a MIDI Map  

A set of MIDI links can be saved into a MIDI map by using the Save MIDI Link As from the File 
menu. Different MIDI maps corresponding to different MIDI controllers can thereby be saved for 
Lounge Lizard Session. A MIDI map can be loaded by double clicking on the corresponding MIDI 
connector icon that appears in the browser when a MIDI map is saved. Furthermore a MIDI map 
can be loaded automatically when an instrument is launched.  

• To assign a default MIDI map, right-click/Control-click on the MIDI map icon and choose the 
MIDI Link Info command. In the Edit Information Window, select the Set as default 
MIDI Links option.  

4.6.2.6. Factory MIDI Map  

A factory MIDI map has been created for the different Lounge Lizard Session controls. This map, 
called Factory MIDI Map, is set as the default MIDI map when Lounge Lizard Session is installed. 
In this map, the following CC (control change) numbers have been assigned to the different Lounge 
Lizard Session parameters as indicated in Table 1.  



ARTURIA – HIPHOP PRODUCER – USER’S MANUAL 62 

Note that it is possible to reload the original version of this MIDI map by importing the factory MIDI 
maps file as explained in Section 4.2.9.  

4.6.2.7. Empty MIDI Map  

The factory MIDI maps include a MIDI map called No MIDI link. As its name suggest this map is 
empty. Loading this map deactivates all the MIDI links.  

It is possible to reload the original version of this MIDI map by importing the factory MIDI maps file 
as explained in Section 4.2.9 in case it was modified by mistake.  

Parameter  CC number 

Piano Type 71 

Keyboard Tune 70 

Tremolo On/Off 80 

Tremolo Mono/Stereo 84 

Tremolo Depth  92 

Tremolo Speed  79 

Drive On/Off  81 

Drive Amount 16 

Effect On/Off  82 

Effect Type  17 

Effect Depth  12 

Effect Rate  13 

Reverb On/Off 83 

Reverb Type  18 

Effect Amount 91 

Effect Decay  75 

Volume  19 
Table 1: Factory CC numbers for the Lounge Lizard Session parameters  

4.6.2.8. Defining a Default MIDI map  

It is possible to define a default MIDI map that will be loaded automatically when Lounge Lizard 
Session is launched.  

• First select a MIDI map by clicking on its icon in the browser and choose the MIDI Link 
Info command from the Edit or the Ctrl-I/Apple-I keyboard shortcut. One can also right-
click/control-click on the MIDI map icon and choose the MIDI Link Info command.  

• To change the default MIDI map select the Mark As Default option.  

4.6.2.9. MIDI Program Changes  

MIDI program changes can be used to switch between programs while playing. Lounge Lizard 
Session will change the number of the current program used by the synthesis engine to the number 
corresponding to the MIDI program change received by the application.  
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4.6.3. Latency Settings  

The latency is the time delay between the moment you send a control signal to your computer (for 
example when you hit a key on your MIDI keyboard) and the moment when you hear the effect. 
Roughly, the latency will be equal to the duration of the buffers used by the application and the 
sound card to play audio and MIDI. To calculate the total time required to play a buffer, just divide 
the number of samples per buffer by the sampling frequency. For example, 256 samples played at 
48 kHz represent a time of 5.3 ms. Doubling the number of samples and keeping the sampling 
frequency constant will double this time while changing the sampling frequency to 96 kHz and 
keeping the buffer size constant will reduce the latency to 2.7 ms.  

It is of course desirable to have as little latency as possible. Lounge Lizard Session however 
requires a certain amount of time to be able to calculate sound samples in a continuous manner. 
This time depends on the power of your computer, the preset played, the sampling rate, and the 
number of voices of polyphony used. Note that it will literally take twice as much CPU power to 
process audio at a sampling rate of 96 kHz as it would to process the same data at 48 kHz, simply 
because you need to calculate twice as many samples in the same amount of time.  

Depending on your machine you should choose, for a given sampling frequency, the smallest buffer 
size that allows you to keep real-time for a reasonable number of voices of polyphony.  

To adjust these parameters:  

• Launch the Audio Control Panel  

• Choose the sampling frequency and the audio format (16, 24, 32 bits)  

• Adjust the buffer size  

Note that this might not be possible on Mac OS or with ASIO drivers on Windows.  

In order to optimize the resources allocated to the calculation of audio by Lounge Lizard Session, it 
is possible to decrease the ratio of resources devoted to the calculation of graphics for the interface 
in favor of audio related calculations. To adjust this ratio, choose the Preferences command under 
the Edit menu and adjust the Performance slider to the desired value between better audio 
performance and smoother graphics. This setting may have little noticeable effect on recent 
computers.  

4.7. Using the Lounge Lizard Session as a Plug-In  

Lounge Lizard Session is available in VST, DXi, AudioUnit and RTAS (for Mac OS only) formats and 
integrates seamlessly into the industry most popular multi-track recording and sequencing 
environments as a virtual instrument plug-in. The plug-in versions will work exactly the same way 
as the standalone version, except for the audio, MIDI, and latency configurations that will be taken 
care of by the host sequencer. Furthermore Lounge Lizard Session works as any other plug-in in 
these environments so we recommend that you refer to your sequencer documentation in case you 
have problems running Lounge Lizard Session as a plug-in. We review here some general points to 
keep in mind when using a plug-in version of Lounge Lizard Session.  

4.7.1. Window Size  

The size of the Lounge Lizard Session window is fixed when it is used as a plug-in.  

4.7.2. Audio and MIDI parameters  

When Lounge Lizard Session is used as a plug-in, the audio and MIDI ports, sampling rate, buffer 
size, and audio format are determined by the host sequencer.  
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4.7.3. Automation  

Lounge Lizard Session supports automation functions of host sequencers. Automation can usually 
be done by using MIDI links and recording MIDI events, or by recording the motion of controls on 
the interface.  

4.7.4. Multiple Instances  

Multiple instances of Lounge Lizard Session can be launched simultaneously in a host sequencer.  

4.7.5. Saving Projects  

When saving a project in a host sequencer, the program list is saved with the project in order to 
make sure that the instrument will be in the same state as when you saved the project when you 
re-open it even if the preset library of the instrument was modified. MIDI links are also saved.  

Note that the default program list (the same as that loaded in standalone mode) appears when 
Lounge Lizard Session is opened in a new project or if a new instance of the plug-in is opened in an 
existing project. To change the default program list, use the Save All Programs command from 
the Programs menu in an instance of the instrument which displays the desired program list.  

4.7.6. MIDI channel  

Make sure that the MIDI controller, sequencer and Lounge Lizard Session all use the same MIDI 
channel. If you are not certain of the channel used by your controller or sequencer, set the MIDI 
channel of Lounge Lizard Session to Omni.  

4.7.7. MIDI program change  

MIDI program changes are supported in the plug-in versions of Lounge Lizard Session. When a 
MIDI program change is received by the application, the current program used by the synthesis 
engine is changed to that having the same number as that of the MIDI program change message.  

4.7.8. Performance  

Using a plug-in in a host sequencer requires CPU processing for both applications. The load on the 
CPU is even higher when multiple instances of a plug-in or numerous different plug-ins are used. To 
decrease CPU usage, remember that you can use the freeze of bounce to track functions of the 
host sequencer in order to render to audio the part played by a plug-in instead of recalculating it 
every time it is played.  

4.8. Quick reference to commands and shortcut 

4.8.1. File Menu 

Command Windows Mac OS Description 

New Folder…  Apple+Shift+N New Folder in the Browser 

Open Preset Ctrl+O Apple+Option+O Open the selected preset 

Save Preset Ctrl+S Apple+S Save the current preset 

Save Preset As…   
Save the current preset under a new 
name 
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Save MIDI Links Ctrl+Shift+S Apple+Shift+S Save the current MIDI links 

Save MIDI Links As…   
Save the current MIDI links under a 
new name 

Import…   Import a .lls file 

Export…   Export a .lls file 

Restore Factory 
Library…   

Restore factory library and programs. 
Everything else in the 

browser is deleted 

Exit (Quit on Mac)   Quit the application 

4.8.2. Edit Menu  

Command  Windows Mac OS Description 

Undo Ctrl+Z  Apple+Z  Undo last command 

Redo Ctrl+Y  Apple+Shift+Z  Redo last command 

Copy Ctrl+C  Apple+C Copy selected item 

Paste Ctrl+V  Apple+V  Paste 

Delete Del   Delete selected item 

Info… Ctrl-I  Apple+I  
Edit information about a selected item 
(browser) 

Compare   
Compare modified preset with original 
settings 

Preferences    Display the Edit Genera 

4.8.3. Audio 

Command  Windows Mac OS Description 

Audio Settings   Display the Audio Settings window 

Audio Control Panel   

Display the Latency Settings window 
if DirectSound is used, the ASIO 
control panel when ASIO drivers are 
used and the Audio MIDI setup 
configuration tool on Mac OS systems 

4.8.4. MIDI  

Command Windows MacOS Description 

MIDI Settings   Display the MIDI Settings window 

Learn MIDI Link   
MIDI link learn mode for the last 
control touched 

Add MIDI Link   
Enables one to add a MIDI link on 
the last controlled touched 

Forget MIDI Link   Drop a MIDI link 
Set MIDI Link Minimum 
Value 

  
Limit the value of a MIDI link to a 
minimum value 

Set MIDI Link Maximum 
Value 

  
Limit the value of a MIDI link to a 
maximum value 

Edit MIDI links    Display the Edit MIDI links window 
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Edit Program Changes…   
Associate presets with MIDI program 
changes 

All Notes Off   Send an all note off signal 

4.8.5. Programs Menu 

Command Windows MacOS Description 

Locate Program in 
Browser 

Ctrl-L Apple-L 
Locate the current program in the 
browser and select it 

Rename Program Ctrl-R Apple-R 
Rename the current program in the 
program list  

Switch to Program Ctrl-P Apple-P Change the current program 

Save All Programs   

Save the entire program list including 
modifications to programs. The list 
will be in exactly the same state the 
next time you open the application 

4.8.6. Help Menu 

Command Windows MacOS Description 

About Lounge Lizard 
Session…   

Display the About Lounge Lizard 
Session window 

User Manual F1  Display the user manual 

Authorize Lounge 
Lizard Session…   

Display the Authorization window. 
Active only if the application has not 
been authorized. 

Visit www.applied-
acoustics.com...   

Launch the browser and go to the 
AAS website. 

Join the user forum…   
Launch the browser and go to the 
AAS forum. 

Get support…   
Launch the browser and go to the 
support section of the AAS website. 

Upgrade to the Lounge 
Lizard EP…   

Launch the browser and go to the 
Lounge Lizard EP upgrade section of 
the AAS website 

4.9. License Agreement  

IMPORTANT! CAREFULLY READ ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT BEFORE 
OPENING THIS PACKAGE. OPENING THIS PACKAGE INDICATES YOUR ACCEPTANCE OF THESE 
TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH THE TERMS AND CONDITIONS OF THIS 
AGREEMENT, PROMPTLY RETURN THE UNOPENED PACKAGE AND ALL COMPONENTS THERETO TO 
THE PARTY FROM WHOM IT WAS ACQUIRED, FOR A FULL REFUND OF ANY CONSIDERATION PAID.  

 

This software program, any printed materials, any on-line or electronic documentation, and any 
and all copies of such software program and materials (the “Software”) are the copyrighted work 
of Applied Acoustics Systems DVM Inc. (“AAS”), its subsidiaries, licensors and/or its suppliers.  
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LICENSE TO USE. The Licensee is granted a personal, non-exclusive and non-transferable license to 
install and to use one copy of the Software on a single computer solely for the personal use of the 
Licensee. Use of the Software is subject to this Agreement.  

 
RESTRICTIONS ON USE. The Licensee may not nor permit third parties to (i) make copies of any 
portion of the Software, other than as expressly permitted under this Agreement; (ii) modify, 
translate, disassemble, decompile, reverse engineer or create derivative and/or competitive 
products based on any portion of the Software; (iii) provide use of the Software in a network, 
timesharing, interactive cable television, multiple CPU service bureau or multiple user arrangement 
to users not individually licensed by AAS, other than as expressly permitted by the terms of this 
license. The Software is licensed to you as a single product. Its component parts may not be 
separated for use on more than one computer.  

 

OWNERSHIP. AAS retains title to the Software, including but not limited to any titles, computer 
code, themes, objects dialog concepts, artwork, animations, sounds, audio effects, methods of 
operation, moral rights, any related documentation and “applets” incorporated into the Software. 
AAS retains ownership of and title to all intellectual property rights in the Software, underlying 
technology, related written materials, logos, names and other support materials furnished either 
with the Software or as a result of this Agreement, including but not limited to trade secrets, 
patents, trademarks and copyrights therein. Licensee shall not remove or alter any copyright or 
other proprietary rights notices contained on or within the Software and shall reproduce such 
notices on all copies thereof permitted under this Agreement or associated documentation. 

 
LIMITED WARRANTY. Except for the foregoing, THE SOFTWARE IS provided “AS IS” without 
warranty or condition of any kind. AAS disclaims all warranties or conditions, written or oral, 
statutory, express or implied, including but not limited to the implied warranties of merchantable 
quality or fitness for a particular purpose, title and non-infringement of rights of any other person. 
AAS does not warrant that THE SOFTWARE will meet the Licensee’s requirements or that the 
operation of the software will be uninterrupted or ERROR-FREE.  

 

LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO 
EVENT WILL AAS BE LIABLE TO THE LICENSEE OR ANY THIRD PARTY FOR ANY INDIRECT, 
SPECIAL, CONSEQUENTIAL, INCIDENTAL OR EXEMPLARY DAMAGES WHATSOEVER, INCLUDING 
BUT NOT LIMITED TO LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA, BUSINESS 
INTERRUPTION OR ANY OTHER PECUNIARY LOSS WHETHER BASED IN CONTRACT, TORT OR 
OTHER CAUSE OF ACTION, EVEN IF AAS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES, EXCEPT IN RELATION TO GROSS NEGLIGENCE OR WILFUL BREACH OF THIS 
AGREEMENT BY AAS. NO AAS AGENT, REPRESENTATIVE OR DEALER IS AUTHORIZED TO EXTEND, 
MODIFY OR ADD TO THIS WARRANTY ON BEHALF OF AAS. THE TOTAL LIABILITY OF AAS FOR 
DAMAGES, WHETHER IN CONTRACT OR TORT, UNDER OR RELATED IN ANY WAY TO THIS 
AGREEMENT SHALL BE LIMITED TO THE LICENSE FEES ACTUALLY PAID BY LICENSEE TO AAS, OR 
IF NO FEES WERE PAID, AAS’ LIST PRICE FOR THE SOFTWARE COVERED BY THIS LICENSE. THE 
EXCLUSION OF IMPLIED WARRANTIES AND/OR THE LIMITATION OF LIABILITY IS NOT PERMITTED 
IN SOME JURISDICTIONS, AND SOME OR ALL OF THESE EXCLUSIONS MAY THEREFORE NOT 
APPLY.  

 
TERMINATION. This License also shall extend to the Software and any updates or new releases 
thereof obtained by the Licensee, if any, subject to any changes to this License made by AAS from 
time to time and provided to the Licensee, provided AAS is under a separate obligation to provide 
to Licensee such updates or upgrades and Licensee continues to have a valid license which is in 
effect at the time of receipt of each such update or new release. This License shall remain in effect 
until terminated. The Licensee may terminate this Agreement at any time, upon notification to AAS. 
This Agreement will terminate immediately without notice from AAS if the Licensee fails to comply 
with any provision of this License. Any such termination by AAS shall be in addition to and without 
prejudice to such rights and remedies as may be available, including injunction and other equitable 
remedies. Upon receipt of notice of termination from AAS, the Licensee must (a) immediately cease 
to use the Software; (b) destroy all copies of the Software, as well as copies of all documentation, 
specifications and magnetic media relating thereto in Licensee’s possession or control; and (c) 
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return all original versions of the Software and associated documentation. The provisions of 
Sections 1, 3, and 5 shall survive the termination of this Agreement.  

 
GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the laws 
of the Province of Quebec, without regard to the United Nations Convention On Contracts for the 
International Sale of Goods and conflict of laws provisions, if applicable, and the parties hereby 
irrevocably attorn to the jurisdiction of the courts of that province. Les parties sont d’accord à ce 
que cette convention soit rédigée en langue anglaise. The parties have agreed that this agreement 
be drafted in the English language.  

 

SEVERABILITY. If any of the above provisions are held to be illegal, invalid or unenforceable, such 
provision shall be severed from this Agreement and this Agreement shall not be rendered 
inoperative but the remaining provisions shall continue in full force and effect.  

 
ENTIRE AGREEMENT. This Agreement is the entire agreement between AAS and the Licensee 
relating to the Software and: (i) supersedes all prior or contemporaneous oral or written 
communications, proposals and representations with respect to its subject matter; and (ii) prevails 
over any conflicting or additional terms of any quote, order, acknowledgment, or similar 
communication between the parties during the term of this Agreement except as otherwise 
expressly agreed by the parties. No modification to the Agreement will be binding, unless in writing 
and signed by a duly authorized representative of each party.  

 

NON-WAIVER. No delay or failure to take any action or exercise any rights under this Agreement 
shall constitute a waiver or consent unless expressly waived or consented to in writing by a duly 
authorized representative of AAS. A waiver of any event does not apply to any other event, even if 
in relation to the same subject-matter.  


